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Dynamic Surface Charts for Scattered 4-D Data in Excel Spreadsheets

Abstract

Visualizations that are low-cost in memory are desirable. We present a method for stitching three-dimensional
scattered data from multiple worksheets into a dynamic “animation-like” surface chart in Excel. This method is
useful when (1) the user hard-codes the data points to conserve memory; employing such strategy scales
better than soft-coding data values, (2) the data values are hard-coded by an unknown source, or (3) the
function is complex and requires a user-defined function to output values into cells. In particular, we
demonstrate an application in biology where rigid motion (rotation and translation are the only
transformations applied to an object in 3-D space) is used to model the free energy gain/loss by surveying
various placements and orientations of membrane proteins with respect to their environment. Our strategy
involves a simple concept of scrolling through an order of worksheets, and can be extended to even more
dimensions (i.e. scrolling through workbooks if necessary)
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Abstract

Visualizations that are low-cost in memory are desirable. We present a method for stitching three-
dimensional scattered data from multiple worksheets into a dynamic “animation-like” surface chart
in Excel. This method is useful when (1) the user hard-codes the data points to conserve memory;
employing such strategy scales better than soft-coding data values, (2) the data values are hard-
coded by an unknown source, or (3) the function is complex and requires a user-defined function to
output values into cells. In particular, we demonstrate an application in biology where rigid motion
(rotation and translation are the only transformations applied to an object in 3-D space) is used to
model the free energy gain/loss by surveying various placements and orientations of membrane
proteins with respect to their environment. Our strategy involves a simple concept of scrolling
through an order of worksheets, and can be extended to even more dimensions (i.e. scrolling
through workbooks if necessary)

Keywords: Dynamic surface charts, animation, scrollbar binding, visualization

1. Introduction

We show how to create a four-dimensional “dynamic” surface chart by binding a
scrollbar to a surface chart. The trick is to bind the value of a scrollbar to a property
of the sheet relating to its name, which implies the sheets need to be in some
countable order, but there are more details to cover in this walkthrough. This proof-
of-concept of generating three dimensional snapshots of a four-dimensional scattered
dataset will be invaluable to all fields that analyze data whose dimensions exceed the
three we are normally comfortable with.

Multidimensional analysis and visualization are still some of the most
underdeveloped features even in the latest Microsoft Excel compared to those of peer
math/statistics software such as Mathematica, MATLAB, R, SAS, SPSS and ParaView.
Yet, they are highly demanded skills in education and technical fields [1]. Visualizing
three dimensional data often involves the surface chart or a contour plot. As
suggested by the initiative and contributed articles of Spreadsheets in Education
[2,3,4], forum discussions [5,6], technical blog posts [7,8,9] and webpages [10,11,12],
the ever-growing user community has also long acknowledged Excel’s potential in
multidimensional math and science education in addition to its well-known roles in
financial analysis [13,14].
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There are two ways to building tools you need to analyze multidimensional data in
Excel. The first is to invest money in professional third-party software (i.e. Nevron,
ComponentOne, Infragistics, etc.) These software are the result of programmers,
businesspeople and mathematicians who recognize that 1) this demand is heavy in
business- and industry-side analytics and that 2) creating a toolset that is compatible
with Excel and other Microsoft Office products most likely improves workflow and
therefore productivity.

The second is to invest time in learning the programming. A reward for doing this is
being able to create a tool catered to your own needs. Microsoft has provided a
programming language within Microsoft Office Applications such as Excel, called
Visual Basic for Applications (VBA). Learning this language not only helps minimize
tedium through automation (i.e. macro recording and replaying), it can also help
create interactive spreadsheets and complex forms, extend functionality by calling
Windows-native and third-party software functions, deploy web services, and more
[15].

Microsoft has developed tools to more easily develop and sell applications/software
beyond those third-party software specialized in extending Office automation. This
foresight in the early 2000s brings forth two important products to those interested in
getting their feet wet in programming/software engineering: the .NET framework
and Visual Studio. The .NET framework is a software development framework that
facilitates programming as well as development of software across multiple
operating systems and web applications across multiple browsers. Visual Studio is a
free integrated development environment - it is a software that helps the developer
organize and test run the layout (form) and the source code behind (function) of
his/her developing product. Visual Studio 2008/2010 Professional, along with other
professional-edition software, is also freely available to students with a valid school
email address from Microsoft's DreamSpark website [16]. Both of these tools are
thoroughly documented [17, 18].

With the introduction of these two main products, Microsoft offers VBA developers a
NET-based alternative for automating Office called Visual Studio Tools for Office
(VSTO) [19]. VSTO seamlessly combines Office and desktop development, thus
expanding the boundaries of software development. However, because VBA has
been integrated deeply into all kinds of business and industrial systems, Microsoft
plans to keep VBA in future shipments of Office [20, 21].

Even with Office automation raised to a whole new level, one of the limiting factors
in promoting creative visualizations is the charting toolset itself. Chart Controls for
NET [22] help extend creating the same type of charts for more environments such
as web services, but does not further improve the flexibility and types of charts. It
cannot be emphasized more that visualizing multidimensional data is a skill of
increasing demand within educational and professional settings. How can students
learn to use these tools if they don’t know what the tools are used for? In order to
address this Catch-22 situation, the Excel (and Office) development team need to
consider a strategy in making data analysis and visualization tools easier to discover
and access in order to attract and motivate students towards learning the higher
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math, statistics and sciences necessary to perform such skills within a
multidisciplinary technology-driven era.

Our work adds to a suite of complex visualization tools that can be built by Excel
programming but do not yet exist conveniently for its users as pre-built Excel
features. To demonstrate the fact that Excel spreadsheet-based multidimensional
analysis is useful in the sciences, we shall first review some prerequisite visualization
concepts and present an application in biology. A walkthrough is then provided to
those interested in understanding how to setup the visualization.

2. Application: A Depth-dependent Energy for Membrane Protein Insertion

2.1. What is Energy and What Qualifies it as a Multidimensional Problem?

Energy is an indirectly observable quantity that allows a physical object, living or
non-living, to exist in one state and be in a different state. There are many types
of energy, such as: kinetic, potential, chemical, electrical, magnetic, sound, and
nuclear. In physics, energy is often described as the ability for a system to do
work. Work is directly computable as a function of forces applied to the system.
Depending on the factors that are assumed to contribute to the work a system
can do (or the work done on a system), one can calculate the change in energy
through the difference of two observable states.

For the sake of simplicity, let's take the gravitational potential energy as an
example.

AE =mgAh (1)

What are we calculating? The difference of potential energy between two states:
an object at a certain height, and the same object at a different height. Our model
assumes two things: 1) we are on Earth and therefore using the gravitational
constant associated with Earth, 2) the object is uniform in composition and has
the same material throughout (this characteristic is called isotropy) and
therefore, can be treated as a point in space. If we rewrite this potential energy as
a function of the remaining one variable (parameter), height, then we have:

AE(h) =mgAh (2)

This is an example of depth-dependent potentials. With a function of one
variable, we can draw a classic two-dimensional graph of AE as a function of h. If
we allow our model to further account for varying mass assuming the same
gravitational constant, we have ourselves a three-dimensional problem because
there are two independent variables, mass of the object and its height:

AE(m , h) = (Am)g(Ah) (3)

If you are contemplating how to draw a three dimensional graph of this potential
function, draw a Cartesian plane on a piece of paper or chalkboard. Label the
axes: mass and height. The logical thing for the value of this potential at any
coordinate pair (Am, Ah) would be the vertical height away from the Cartesian
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plane. The resulting graph you would be observing is a three-dimensional one,
called a surface chart, and is already difficult for humans to draw.

The way we resolve the problem of being unable to draw in 3-D space is to draw
2-D projections of a three-dimensional object. When you observe an artist trying
to draw a 3-D object on a canvas, this artist is visualizing what the 3-D object
looks like from a certain perspective and drawing that mental snapshot. If the
reader is interested in the theory behind the proper construction of these 2-D
projections of the 3-D object (in this case, a surface chart), we encourage the
reader to study Banecka’s recent article [4] and to further research on the topic of
projective geometry.

Let us return to the gravitational potential function. What if the gravitational
constant is observed on many celestial bodies besides the Earth? Then we will
have introduced a third variable into the equation:

AE(m, g h) = (Am)(Ag)(Ah) )

Now, not only do we have to draw 2-D projections of the 3-D surface chart, there
is a third variable in play making the 3-D surface chart change. The entire surface
changes because of a unit change in this third variable. One way to visualize this
is to draw multiple surface charts for each value of the third variable. Depending
on the continuity (and the interval step size) along this dimension of this third
variable, and therefore of these snapshots, it may benefit the person visualizing
the dynamic surface chart as either a movie (small step size) or a collection of
snapshots. We will demonstrate how to draw 3-D projections of a 4-D chart in
Excel. The figure below shows that we can easily generate such an animation
chart using a simple formula for the cell range E2:012 and binding the value of g
to the scrollbar (Fig. 1).

=G51*$D4*$BS2

Figure 1: Binding a scrollbar with a surface chart of AE(m ,g, h) = mgh requires linking the scrollbar
to a cell value, then using the cell value inside each cell formula of the surface data we plan to
change. Although one can survey different combinations of masses (row values in red) and heights
(column values in blue) coupled with varying gravitational constants from 1 to 10 (scrollbar linked
with cell B2, boxed in dark blue).

http://epublications.bond.edu.au/ejsie/vols/iss1/2



Hsieh and Nanda: Dynamic Surface Charts

If the reader seeks more practice material for producing a dynamic surface chart
based on cell formulae, an in-depth tutorial involving two scrollbars is provided
[23].

2.2. Membrane Proteins in Medicine and Nanobiotechnology

Membrane proteins are very important molecules — they are groups of atoms
arranged in some order and connected to be functional units in biology. They
tfloat dynamically within the cell membrane, a biological envelope that separates
the contents of the cell from the rest of its surrounding environment. The
membrane proteins we have studied perform functions such as transporting
nutrients, transmitting signals from the outside of the cell to the inside (and vice
versa), and attacking cells that are foreign and considered threatening to itself
(this harmful attack is called virulence) [24]. These are the same proteins behind
the deadly and virtually untreatable “superbug” called methicillin-resistant
Staphylococcus aureus, also known as MRSA (pronounced “mersa”) [25]. These
membrane proteins are responsible for rejecting the drugs scientists have been
developing.

While membrane proteins in MRSAs pose threats to humans, they are also
exciting candidates in nanobiotechnology. The properties of these membrane
proteins can be tweaked for other applications such as biofuel production and
detection of chemicals present in bodies [26]. A necessary step is to identify
amino acids in the sequence that can tolerate the mutation while preserving the
structural integrity of the protein. For the membrane proteins found in MRSAs,
functions that assess how well the protein incorporates into natural membranes
have been developed [27, 28]. Depending on the type of amino acid in the
protein sequence and its depth in the membrane, the function yields different
energies. To derive the total energy of the protein, we simply calculate the sum
of the amino acid energies. Section 6 is a technical appendix for these depth-
dependent energy calculations.

2.3. Membrane Proteins in a Lipid Environment

When each amino acid in a membrane protein sequence has an energy that
depends on its depth in the membrane, one can see that rigid motions of the
entire protein (i.e. translations and rotations) yield different corresponding
values of insertion energies.
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Figure 2: A schematic of a membrane protein situated in a lipid environment

The main component of the environment, the lipid molecule, is composed of
water-loving and water-avoiding components. When placed together in water, a
result of many lipid molecules is that the water-loving sides will still interface
with water molecules while water-avoiding components will be shielded away
from interaction with water. This leads to the formation of a bilayer. When a
membrane protein is introduced to this environment, the lipids adjust their
water-loving components called headgroup regions (blue ellipses) to match
placement of amino acids that best interact with them (colored purple). These
particular amino acids tend to interact with the headgroup regions of the lipid
bilayer, thus readjusting the positions of certain lipid molecules and deforming
the overall bilayer (Figure 2). Thus, it is not hard to imagine that the membrane
protein has limited orientation that achieves the best energy given the lipid
molecules do not escape too far as to break the bilayer itself. What are the
favorable rigid motions of the protein with respect to the center of the lipid
environment?

We have developed a way to visualize all insertion energy values from applying
rigid motions (this visualization is called the energy landscape) by creating a
dynamic Excel surface chart tool. Briefly, the energy landscape data is arranged
in multiple worksheets in the order of the membrane protein’s depth with
respect to the center of membrane, and the data of energy values from rotating
the protein at a fixed depth is located within that corresponding worksheet.
Chapter 2 explains how one can set up a similar visualization for four-
dimensional data that can be sliced along one dimension.

2.4. Visualizing the Rigid Motion of Membrane Proteins using Dynamic
Surface Charts

One way to visualize the orientation of proteins in membranes is through surface
charts, which convey the information of energy landscapes. The 3-d orientation
of a membrane protein can be expressed as a combination of rotations by x- and
y-axes. The resulting energy from that orientation is the value of that surface
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chart corresponding to the orientation coordinates. A static surface chart cannot
suffice in communicating 4-d data of the insertion energetics because we also
need to visualize depth information. Hence, some sort of animation, with the
depth as the fourth dimension, is needed. A solution in setting up such an
animation involves indirect binding of a scrollbar to a property of the multiple
sheets of scattered data (Fig. 3).

Here we provide a walkthrough and the thought process behind setting up this
scrollbar-based solution. The code is provided in Excel files with the suffix
“_withCode”. The code (text only) is in the .bas file. Users with versions lower
than 2003 will most likely not be able to implement or view this workbook

properly.

Holding ZShift constant at 0 A rotating around x{rows)
and y(columns) axes at steps of pi/18

O-’—

-15
m-15-0

W-30--15

1
z
3
a
5
]
7
8

m-45--30

m-60--45

Total Energy of Insertion

m-75-60
3 W-90--75

-2 5 ) e 2 u-105-90

Hod » M 229 (230 .23l 23 233 (z34 . z35  z36 237 .z38 .z39 . z40 DataForPlot MR

Figure 3: Energy landscape generated by sampling rotations about x- and y-axis of a protein at
given depth in membrane. Here, a depth value of 0 A corresponds with the protein center of mass
situated in the center of the membrane. Binding a scrollbar allows one to visualize multiple
landscapes along the fourth dimension of depth.
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3. Setting up the Visualization Example

3.1. Prerequisites and Assumptions

This project contains VBA (Visual Basic for Applications) code that requires
knowledge only to change the visualization, not run it. We assume the reader has
access to either Microsoft Excel 2010, 2007, or 2003 for PC. If the reader has Office
for Mac, versions 2011 should be able to run VBA, but not 2008, which omitted
VBA as a feature [12]. Versions 2003 and 2004 will require a converter.

We will be using the terms “macro” and “VBA” frequently. Here is the relation
between the two terms: a macro is computer-generated code in VBA, which is a
special subset language of Visual Basic that manipulates Excel, Access,
PowerPoint and other Office applications. Since the macro is computer-
generated, it is less elegant to read longer macros. However, for those learning to
program in VBA, recording a macro helps organize procedures into
programming logic [2].

The terms “subroutine” and “function” will also be used frequently in this
walkthrough. A subroutine can be procedural but does not return a value for
other blocks of code to use. A function is a subroutine that does return a value,
but cannot run on its own.

What we will be doing is discuss the big picture behind the VBA code of the
provided example. For those interested in learning VBA at beginner to
intermediate level, we recommend the “Power Programming with VBA” series
for versions 2003 and 2010 by John Walkenbach [29, 30].

3.2. Enable Macros and Display Developer Tab (PC version)

We assume the reader has not yet set preferences with regards to macro security.
By allowing macros in this worksheet, you have access to viewing, running and
editing the code running behind a worksheet.

Open file “DynamicSurfaceChart_withCode.xlsm” and choose “Enable Macros”.
If you are using 2003, please open the .xls version of the file and proceed in a

similar fashion. You may find more info on macro security settings on the
Microsoft Office site [31, 32].

Next, we display the Developer Tab, which is a menu for easier access to the
VBA Editor, macros and other programming/design tools.

Go to File> Options=> Customize Ribbon=> Customize the Ribbon (on the right
side)> Choose Main Tab. Check the box that says “Developer” to reveal the
Developer tab. For Excel 2007, go to File> Options> Popular. Check the box
that says “Show Developer tab in the Ribbon”.

Enable Macros and Display Developer Tab (Mac version):

In Excel 2011, choose the “Enable Macros” option upon opening the file
“DynamicSurfaceChart_withCode.xIsm”. For Excel 2004, you will need open the
tile “DynamicSurfaceChart_withCode.xls.” and go through a similar process. If
you choose the file with “_withCode”, you may skip section 3.3.

http://epublications.bond.edu.au/ejsie/vols/iss1/2
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For showing the Developer Tab in 2011, go to Excel> Preferences—> Ribbon.
Under “Show or Hide Tab or drag them into the order you prefer”, scroll down
the list and check “Developer”.

3.3. Import VBA code into a VBA module

Once macros are enabled for Excel, we are ready to import the provided VBA
code and test run the visualization. Excel allows its users to export VBA code to a
“.bas” (BASIC) file type for ease of transferring to other Excel applications [33].
We did exactly that so that the reader can import the code from a .bas file into a
VBA module. If the reader is unable to load the .bas file due to technical reasons,
we have prepared a second version of the Excel workbook that comes with the
VBA code preloaded called “DynamicSurfaceChart_withCode.xIsm”. If you are
using this particular version of this workbook, you may skip the remainder of
this section and proceed to section 3.4.

We will need the two files for this exercise: “DynamicSurfaceChart.xlsx” or “.xls”
(for 2003 and 2004 versions) and “DynamicSurfaceChart.bas”. Open
DynamicSurfaceChart.xlsx or .xlIs. If you have enabled macros, then you
shouldn’t see notifications regarding macro security. If you have not done so,
you should check the option to allow macros for this file. You should only see
sheets labeled “z_-40" to “z_40", a total of 81 sheets in numerical order (Fig. 4).

A1 - Holding z constant at40 A, rotating around x{rows) and y(columns) axes st steps of /18 -
A B c p | E | F | & | wu | 1 3 K L M N o P Q R s T
1 [Holding z constant at 40 A, rotating around x{rows) and y(columns}) axes at steps of r/18__|
2 40 B E) 7 5 S 2 E} 2 1 [ 1 2 : a s 6 7 3 s
3 5 07056 -0.71185 -0.74353 -0.73159 -0.73368 -0.77509 -0.85053 -0.96757 -108432 -123593 -139207 -1.66223 -175502 156622 -LA40113 L1787 -0.95571 -0.76451 -0.7056
a 8 -0.7056 -0.71507 -0.7377 -0.7327L -0.72582 -0.75291 -0.82327 -0.93304 -L01987 -L09417 -123233 -149037 -161258 -148208 -1.35986 -L15297 -0.96411 -0.77867 -0.7056
s 7 07056 -0.71566 -0.70432 -0.68646 -0.68543 -0.72151 -0.78412 -0.874%6 -0.96638 -L01406 -111772 -13007 -13952 -1.36236 -1.30323 -L17568 -0.97177 -0.78728 -0.7056
6 6 -0.7056 -0.70401 -0.67936 -0.66322 -0.6654 -0.68078 -0.71557 -0.78858 -0.86478 -0.92883 -100502 -1.02296 -1.10954 -1.14103 -1.24583 -L18484 -0.99655 -0.79534 -0.7056
7 5 -0.7056 -0.69398 -0.66001 -0.65282 -0.64618 -0.65013 -0.68856 -0.71152 -0.75185 -0.77582 -0.83186 -0.87596 -0.9538 -0.357%6 -11456 -L17927 -L0115 -0.80411 -0.7056
8 4 07056 -0.6855 -0.64669 -0.65129 -0.62479 -0.61285 -0.59504 -0.6436 -0.71081 -0.7427 -0.76803 -0.87249 -0.84523 -0.86564 109957 -L19279 -100437 -0.80952 -0.7056
9 3 -0.7056 -0.67846 -0.63857 -0.64449 -0.59868 -0.56822 -0.61316 -0.67916  -0.738 -0.75858 -0.87441 -0.89299 -0.78916 -0.84574 -1.07935 -L18082 -0.99202 -0.8065 -0.7056
2 -0.7056 -0.67278 -0.64153 -0.63451 -0.61657 -0.63227 -0.69282 -0.78392 -0.79842 -0.86547 -0.95443 -0.89353 -0.79328 -0.86547 -1.09958 -L14294 -0.9683 -0.79647 -0.7056
1 07056 -0.66852 -0.6587 -0.64007 -0.6626 -0.74263 -0.81058 -0.86472 -0.93078 -0.99061 -0.96825 -0.90788 -0.79981 -0.91103 -1.10853 -L104S1 -0.94093 -0.78553 -0.7056
0 -0.7056 -0.66583 -0.68754 -0.67412 -0.73529 -0.81622 -0.90758 -0.97425 -L075%4 -L0SS1S -0.9789 -0.91367 -0.83666 -0.36037 -1.1028 -LOGOTE -0.90632 -0.77425 -0.7056
1 07056 -0.66538 -0.70991 -0.72416 -0.82777 -0.92583 -1.00469 -1.08821 -L.17772 -L07341 -L02846 -0.91717 -0.8905 -0.98363 -1.07146 -101287 -0.8716 -0.76179 -0.7056
2 07056 -0.67006 -0.74172 -0.79743 -0.93872 -103759 -109132 -1.15654 -1.19943 -1.10953 -102286 -0.91872 -0.94431 -103859 -1.04634 -0.95514 -0.82702 -0.74843 -0.7056
3 07056 -0.67864 -0.76533 -0.8763 -10621 -109323 -114457 -1.23746 -1.24353 -1.14269 -0.98777 -0.91663 -10208 -106116 -1.00587 -0.3036 -0.79135 -0.73485 -0.7056
4 -0.7056 -0.68309 -0.78474 -0.94025 -1.14886 -1.1798 -L24144 -L32786 127749 L1356 -0.98661 -1.01975 106583 -1.02332 -0.34068 -0.84482 -0.75864 -0.72172 -0.7056
5 -0.7056 -0.70168 -0.80888 -0.96675 -11931 -1.28153 -1.34228 -142343 -128557 -118406 -109543 -10677 -1040S5 -0.96382 -0.86221 -0.78816 -0.72685 -0.7097 -0.7056
6 07056 -0.72057 -0.843%8 -102063 -12349 -135483 -144867 -147601 1375 -1.25693 -112202 -L07193 -100406 -0.88707 -0.80433 -0.74638 -0.70613 -0.70691 -0.7056
7 07056 -0.73953 -0.88065 -109528 -124638 -147965 -1.6049 -160782 -1.38514 -1.25272 -L14303 -L02733 -0.93994 -0.84268 -0.78135 -0.74769 -0.7205 -0.70759 -0.7056
8 -0.7056 -0.75085  -0.93 -1.1606 -13213 -1.59497 -L74837 -L68575 -14289 -127063 -112979 -101028 -0.89073 -0.80079 -0.75117 -0.73715 -0.72965 -0.71054 -0.7056
9 -0.7056 -0.76451 -0.95571 11787 -140113 -1.56622 -L75502 -L66223 139207 -123593 -108432 -0.96757 -0.85053 -0.77509 -0.73368 -0.73159 -0.74353 -0.71186 -0.7056

7 40 AF i

Figure 4: You will see only Excel data (of this format) when you first open
DynamicSurfaceChart.xlsm

3.4. Running the VBA code in the Module “DynamicSurfaceChart”

When in Excel (make sure the application is the active window), press Alt+F11 to
open up a new window called the Visual Basic Editor (For Mac users,
Alt+Fn+F11). This editor will be the environment in which you code and test
your VBA and macros. (Fig. 5) If you don’t see the panels in Figure 8, go to View
and select the Project Explorer, Properties Window, Immediate Window, and
Locals Window. The Project Explorer gives you a view of all workbooks,
worksheets and associated VBA code/macros in a hierarchical structure. The
Properties Window allows you to view and modify properties of selected object.
(workbook, worksheet, code) The Immediate Window is used to monitor outputs
alphanumerical data from running test code. The Locals Window can help you
track changes to variables when you run the code line by line.
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i

Type a question for help =]

Evveipeisble  Fobe - b D -

Figure 5: the Visual Basic Editor after opening up the four panels

In the Visual Basic Editor, right-click the “ThisWorkbook” icon (highlighted blue
in Fig. 5) and select “Import File...” Locate and select the
DynamicSurfaceChart.bas file for import. You should now have a new folder
called Modules containing a VBA module called “DynamicSurfaceChart”. If you
do not immediately see the code, double-click on the DynamicSurfaceChart
module. Click once inside the “test_S3DP()” subroutine as shown (Fig. 6):

Option Explicit

Dim cellWidth As Double
Dim cellHeight As Double
Dim pi As Double

Sub test_S3DP()
'how to use if first testing this code:

'l)delete these last two sheets: "DataForPlot” and "3DPlot”
*2)click once to place cursor within this subroutine

'3)press FS to run this subroutine Place cursor
‘no:e:l
*If user wants to import his/her own data, somEWhere
- Sheetd (z_-35) ‘the user will need to edit the transformation in Setup_Mains! H
~4&] ThisWorkbook H 'as suited to the user's needs in here then
-3 Modules
43 DynamicSurfaceChart o cellWidcth = Range ("Al") .Widch press F5 to
R - naym .
P e — 3 cellHeight = Range("Al") .Height
pi = WorksheetFunction.pi() run SUbrOUtlne
Properties - DynamicSurfaceChart x|
DynamicSurfaceChs Module - Dim xLen As Integer, ylen As Integer
xLen = countSteps(-1 * pi / 2, pi / 2, pi / 18)
Alphabetic | Categorized
o ‘l] ‘ m J
|DynamicSurfaceChar
Immediate | Locals
+ [ Ready>

| Expression

< (] »

Figure 6: A view of the DynamicSurfaceChart code in the Visual Basic Editor.
Press F5 to run the “test_S3DP” subroutine.

For Mac users, go to Developer=> Macros=> run “test_S3DP” or Developer->
Editor-> place cursor in “test_S3DP” and press F5.

http://epublications.bond.edu.au/ejsie/vols/iss1/2
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After the code is finished running, you should see two new sheets created called
“DataForPlot” and “3DPlot”. The worksheet “DataForPlot” contains the dynamic
range dependent on the scrollbar value in “3DPlot”. Go to the worksheet called
“3DPlot” (as shown in Fig. 3) and manipulate the scrollbar around. Notice that
when the scrollbar value is changed, the surface chart is updated and the data in
“DataForPlot” change as expected. “DataForPlot” is pulling data from a specific
“z_" data sheet using VBA generated cell formulae.

3.5. Underlying Logic of the Code You Just Ran

Let us formally state the problem in the context of dynamic surface charts: We
want to build a tool that consolidates multiple (3-D) surface charts into a
single visualization tool. In order to attain such a goal, we can divide the
problem into more bite-sized chunks:

1. We will require worksheets containing data that is formatted for outputting a
surface chart.

2. Since we will display multiple 3-D surface charts, we will need to know how
to output at least one surface chart programmatically through VBA.

3. People can only see one surface chart at a time. Therefore user interaction is
necessary to indicate their selection of a particular surface chart out of many.
It would be useful to consider scrollbar binding to a changing cell value of a
static worksheet containing data.

We will henceforth call this virtual data worksheet “DataForPlot”, and the
worksheet that displays the dynamic surface chart “3DPlot”. The corresponding
subroutine calls are “Setup_MainSheet” and “Setup_PlotSheet”. The vision is to
use the scrollbar to scroll through sheets of data as well as their corresponding
surface charts.

The following sections will review the mechanics behind each major subroutine
and function. We then review the test subroutine that calls these subroutines and
functions in a procedural manner.

3.6. Preparing the Dynamic Range: The “Setup_MainSheet” Subroutine

Viewing the data using our dynamic surface chart to view individual 3-D slices
of 4-D animation is like using a microfilm machine to view individual slides of
archived newspaper articles. The machine is composed of a magnifying lens and
a slide sorter consisting of multiple slides. The “Setup_Mainsheet” subroutine is
responsible for loading a particular slide’s data to be magnified and viewed. The
worksheet responsible for preparing this view at the particular 3-D data is called
“DataForPlot”. As with the microfilm machine, the user manually scrolls to a
certain slide, which is properly indexed. Similarly, our data is indexed in
numerical order from -40 to 40 A (for the biology example). “DataForPlot” also
reports the index number of the slide for viewing. Since the scrollbar can only
take numbers 1, 2, 3 and so on, the index number of the 3-D data needs to be
translated into the scrollbar value via a simple mathematical formula. Depending
on the scrollbar value, and therefore the index number of the 3-D data to “view”,

Published by ePublications@bond, 2012
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the dynamic range reports the corresponding data values of the particular 3-D
slice of the 4-D animation.

3.7. Displaying the Surface Chart Animation: The “Setup_PlotSheet”
Subroutine

While the “DataForPlot” sheet is like the prepared slide for microfilm viewing,
the surface chart animation is the viewer itself. The “Setup_PlotSheet”
subroutine prepares both the surface chart visualization tool and the scrollbar.
The visualization tool is the interface between the user and the data. To control
the index number of the 3-D slice of the 4-D animation, the subroutine generates
a scrollbar, whose value dictates which particular 3-D data to view. When the
scrollbar value is changed, the value of index reported in “DataForPlot” updates
accordingly, and vice versa.

3.8. Giving the Surface Chart Analytical Meaning: the “ColorGrad” Function

When a surface chart is created, Excel does not create meaningful legend colors.
They start off as random colors. There exist useful websites demonstrating how
to implement gradient-based color schemes [34] for heat maps (contour plots)
[35, 36] and therefore surface charts by extension. “ColorGrad” paints the surface
chart with a meaningful color gradient, so that visualization and analysis will be
easier for those reading the surface chart.

3.9. Putting It All Together with the “test_S3DP” Subroutine

The test subroutine, here called “test_S3DP” (short for testing surface 3-D plot),
is a subroutine without arguments used to call the two main subroutines: one
that generates a sheet “Setup_MainSheet” with virtual data, and another
“Setup_PlotSheet” that generates the surface plot. It is necessary to write at least
one subroutine without arguments because subroutines with arguments cannot
be directly run unless the arguments are indicated in a call. Therefore this type of
subroutine call needs to be performed within a testing subroutine. The next page
shows a schematic of the interplay between all the sheets created through the
VBA code we have discussed (Fig. 7).

3.10. Optional: Replace Current Scrollbar with ActiveX Scrollbar for Fluid
Animation

The animation of the dynamic surface chart could be continuous and can be
viewed by holding down the arrow key on the scrollbar. However, this requires
some manual replacement of the forms version of the scrollbar (the one
implemented here) with an ActiveX version of the scrollbar. The following steps
show the reader how to manually install the ActiveX scrollbar:

Mac users cannot proceed with this tutorial as Mac Offices are not ActiveX
compatible.

1. Delete the scrollbar on the sheet “3DPlot” by right-clicking it once and
pressing Cut.

http://epublications.bond.edu.au/ejsie/vols/iss1/2
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In Developers tab, go to Insert 2 ActiveX Controls = Scroll Bar
Activate “Design Mode” in the Developers tab

Draw out a scrollbar underneath the surface chart

Right-click the scrollbar while in Design Mode - Properties
Change the field “Min” from 0 to 1

Change the field “Max” from 32767 to 81

Exit the Properties dialog

Right-click the scrollbar - View Code

. Insert the following code:

Private Sub ScrollBarl_Change()
Sheets("DataForPlot").Cells(2, 1) = ScrollBar1.Value

End Sub

Private Sub ScrollBar1_Scroll()
Sheets("DataForPlot").Cells(2, 1) = ScrollBar1.Value

End Sub

Go back to “3DPlot” and exit the Design Mode.

You can now hold the right arrow on the scrollbar and watch the movie-like
animation.
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Figure 7: A schematic of sheets “z_-40" to “z_40",
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4. Discussion: What our Visualization Tells Us

By linking our scrollbar values 1 to 81 with the biologically relevant energies at
depths from the center of the bilayer, z = -40 to 40 A, we can now visualize the
landscape of all possible orientations of a single protein. We have prepared the
surface chart animation along with the corresponding biophysical animation as one
animated GIF file. Please download “insertionAnimation.gif” and view it in
PowerPoint or your favorite animated GIF viewer program.

By using VBA to automate this visualization process for each protein, we found a
pattern that verifies our potential: that every protein reaches an energy minimizing
orientation when situated in the center of the membrane. Since we have surveyed all
orientations, we see that this corresponds to an energy funnel (think lowest ground
in a valley), where amino acids have reached their optimal placement of the entire
corresponds with a stable orientation. This tool could be applied further to delve into
the preference of insertion pathway for membrane proteins, i.e. from outside the cell
(extracellular space) towards intracellular space versus the scenario vice versa.

5. Conclusion

We show that through programming a surface chart whose data points are indirectly
bound to the name of sheets of interest that dynamic surface charts can be created in
Excel. Although we developed a solution in the context of evaluating protein depth-
dependent energy with respect to the center of the membrane and orientation in 3-D
space, a dynamic surface chart could benefit all kinds of fields that need to visualize
multidimensional data, including finance, economics, theoretical and applied
sciences, etc.

6. Appendix: Energy Landscape Calculations for Each Depth z = -40 to 40 A

Any membrane protein sequence is composed of tens to hundreds of amino acids.
Each amino acid in these sequence is one of twenty amino acid types, each with their
own energy function associated [27, 28]. The associated energy of insertion for each
amino acid within the membrane protein sequence is contained in a worksheet called
“Hybrid”. (Fig. 8) This worksheet is then subjected to rigid motion transformations
and other downstream calculations (VBA code not included). Since only the depth
and amino acid type are the only relevant parameters in this model of insertion, the
rigid motion transformations are applied only to the z-values (the depths) of the
amino acids. The sum of the resulting energies are changed as well, and then
summed. Each surface chart value in the sheets “z_-40”, “z -39” ... “z_39”, and
“z_ 40" is the result of an orientation and then vertical translation of the membrane
protein. This is a far more complex calculation than the potential energy setup
described in Section 2.1 and requires the 81 sheets as intermediate data output for the
visualization.
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